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Computer Fundamentals 3 
 

 

 

Preface 

I am glad to present this book, especially designed to serve the needs 

of the students. The book has been written keeping in mind the general 
weakness in understanding the fundamental concepts of the topics. The book 
is self- explanatory and adopts the “Teach Yourself” style. It is based on 
question- answer pattern. The language of book is quite easy and 
understandable based on scientific approach. 

Any further improvement in the contents of the book by making 
corrections, omission and inclusion is keen to be achieved based on 
suggestions from the readers for which the author shall be obliged. 

I acknowledge special thanks to Mr. Rajeev Biyani, Chairman & Dr. Sanjay 
Biyani, Director (Acad.) Biyani Group of Colleges, who are the backbones and 
main concept provider and also have been constant source of motivation 
throughout this Endeavour. They played an active role in coordinating the 
various stages of this Endeavour and spearheaded the publishing work. 

I look forward to receiving valuable suggestions from professors of various 
educational institutions, other faculty members and students for improvement of 
the quality of the book. The reader may feel free to send in their comments and 
suggestions to the under mentioned address. 

 

Author 

 

 

 

 

 

 

 

 

 

 

 

 



Syllabus 

 

UNIT- I 
Introduction to Computers: Characteristics of computers, Evolution of 

computers, generation of computers, Block diagram of computer & role of each 

block, classification of computers. Input and Output Devices 

Primary and Secondary Memory: Memory hierarchy, Random access 

memory (RAM), types of RAM, Read only memory (ROM), types of ROM. 

Classification of secondary storage devices, magnetic tape, magnetic disk, 

optical disk. 

Number Systems: Introduction to number system, Binary, Octal, Hexadecimal, 

conversion between number bases, Arithmetic operations on binary numbers, 

Alphanumeric- BCD, EBCDIC, ASCII, Unicode. 

UNIT-II 
Computer Software: software categories, system software, application 

software, utility software. Classification of system software, Computer

 Languages: Introduction, 

classification of programming languages, generations of programming 

languages, features of a good programming language. 

Internet Basics: Introduction,, Features of Internet, Internet applications, 

Services of Internet,Logical and Physical addresses, Internet Service Providers, 

Domain Name System. Web Basics : Introduction to Web, Web browsers, 

http/https,URL. 

UNIT-III 
MS Word: Word processing, MS-Word features, creating saving and opening 

documents in Word, interface, toolbars, ruler, menus, keyboard shortcut, 

editing, previewing, printing & formatting a document, advance features of MS 

Word, find & replace, using thesaurus, mail merge, handling graphics, tables, 

converting a Word document into various formats like-text, rich text format, 

Word perfect, etc. 

MS Excel: Worksheet basics, creating worksheet, entering data into 

worksheet, data, text, dates, alphanumeric values saving & quitting worksheet, 

opening and moving around in an existing worksheet, Toolbars and menus, 

Keyboard shortcuts, working with single and multiple workbook, working 

with formula & cell referencing, Auto sum, coping formulas, absolute and 

relative addressing, formatting of worksheet, previewing & printing 

worksheet, Graphs and Charts, Database, macros, multiple worksheets- 

concepts. 

UNIT-IV 
Power Point: Creating and viewing a presentation, managing Slide Shows, 

navigating through a presentation, using hyperlinks, advanced navigation with 



 

action setting and action buttons, organizing formats with MasterSlides, 

applying and modifying designs, adding graphics, multimedia and special 

effects. 

Microsoft Access: Planning a database (tables, queries, forms, reports), 

creating and editing database, customizing tables, linking tables, designing and 

using forms, modifying database structure, Sorting and Indexing database, 

querying a database and generating reports.  



Chapter 1 

Computer History and Hardware 

 
Q.1. Explain about the evolution of Digital Computers. 

Ans.: The successful general purpose mechanical computers were developed. In 1930, 

mechanical calculations were built for automatic addition, subtraction, 

multiplication & division. A calculator is not a programmable device.  The 

different eras of the evolution of the computer are listed below: 

(1) Mechanical Era : There were many attempts to create a m/c that could 

help to perform various calculations. In 1823, Charles Babbage tried to 

build a mechanical as computing m/c capable of performing automatic 

mathematical calculations. This was designed to compute tables of 

functions such as logs functions etc. In 1830‟ s Babbage made a more 

powerful mechanical computer. This m/c was designed to perform any 

mathematical calculation automatically. It could perform addition etc. It 

had a memory unit. Its capacity was 1000 numbers, each no. consisting of 

50 digits. The m/c was a programmable m/c. It had mechanism for 

enabling a program to change the sequence of its operations automatically. 

In the late 19th century punched cards were commercially used. Soon IBM 
was formed in 1924. Konand Zuse developed a mechanical computer, the 
Z1, in 1938 in Germany. 

(2) The Electronic Era : The first electronic computer using. Valves were 

developed by John V. Atanas off in the late 1930‟ s. It contained add- 

subtract unit. It was relatively a small computer and used about 300 valves. 

Its memory unit consisted of capacitors mounted on a rotating drum. It 

used a no. of I/O devices including a card punch and a card reader. The 

first popular general electronic digital computer was the ENIAC 



 
 

 

(Electronic Numerical Interpreter and calculator). John von Neumann was 

the consultant of the ENIAC project. The ENIAC used a high speed 

memory to store both programs as well as data during program execution. 

Neumann and his colleagues designed and build the IAS Computers. It 

used RAM consisting of a cathode ray tube. The transistors were invented 

in 1948 at AT&T bell laboratories. Slowly they replaced Vacuum tubes. 

IC‟ s were first introduced, ie, designed and fabricated in 1958-59. The 

examples of computers using IC‟ s are-: IBM – 370 & PDP-8. In 1970 LSI 

chips were introduced is form of memory units. Computers built in 1970‟ s 

& onwards used micro process and other LSI, VLSI and ULSI components. 

 
Q.2. What were the different Computer Generations? 

Ans.: The various generations of the computers an listed below : 

(i) First Generation (1946-1954) : The digital computes using electronic values 

(Vacuum tubes) are known as first generation computers. The high cost of 

vacuum tubes prevented their use for main memory. They stored 

information in the form of propagating sound waves. 

(ii) Second Generation (1955-1964) : The second-generation computer used 

transistors for CPU components & ferrite cores for main memory & 

magnetic disks & tapes for secondary memory. They used high-level 

languages such as FORTRAN (1956), ALGOL (1960) & COBOL (1960). I/O 

processor was included to control I/O operations. 

(iii) Third Generation (1965-1974) : The third-generation computers used IC‟ s 

(SSI& MSI) for CPU components. Semiconductor memories were LSI chips, 

Magnetic disk & tapes were used as secondary memory. Cache memory 

was also incorporated in the computers of 3rd generation. Micro 
programming, parallel memory multiprogramming etc were introduced. 
E.g. Of third generation computers are PDP II etc. 

(iv) Fourth Generation : In 4th generation computers microprocessors were 
used as CPU‟ s VLSI chips were used for CPU memory & supporting 
chips. 



 
 
 

 
 

 

Computer of this generation were very fast. 8, 16 & 32 bit microprocessors 

were developed during this period. Main memory used fast 

semiconductors chips up to 4 M bits size. Hard disks were used as 

secondary memory. Keyboards, dot matrix printers etc. were developed. OS-

such as MS-DOS, UNIX, Apple‟ s Macintosh were available. Object oriented 

language, C++ etc were developed. 

(v) Fifth Generation (1991- continued) : 5th generation computers use ULSI 

(Ultra-Large Scale Integration) chips. Millions of transistors are placed in a 

single IC in ULSI chips. 64 bit microprocessors have been developed 

during this period. Data flow & EPIC architecture of these processors have 

been developed. RISC & CISC, both types of designs are used in modern 

processors. Memory chips and flash memory up to 1 GB, hard disks up to 

600 GB & optical disks up to 50 GB have been developed. 

 
Q.3. Explain about the Von-Neumann Architectures. 

Ans.: In this type of architecture, the computer consisted of a CPU, memory and I/O 

devices. The program is stored in the memory. The CPU fetches an instruction 

from the memory at a time and executes it. Thus, the instructions are executed 

sequentially which is a slow process. Neumann m/c are called control flow 

computer because instruction are executed sequentially as controlled by a 

program counter. To increase the speed, parallel processing of computer have 

been developed in which serial CPU‟ s are connected in parallel to solve a 

problem. 

Even in parallel computers, the basic building blocks are Neumann processors. 
 

Q4.    Explain the block diagram of computer system? 

Ans: A computer can process data, pictures, sound and graphics. They can solve highly 

difficult hitches quickly and accurately. A computer performs basically five major 

computer operations or functions. These are 

1) It accepts data or instructions by way of input, 



5) It controls all operations inside a computer. 
 
We discuss below each of these Computer operations 

Fig: Basic computer Operations 

1. Input: This is the process of entering data and programs in to the computer 

system. You should know that computer is an electronic machine like any other 

machine which takes as inputs raw data and performs some processing giving out 

processed data. Therefore, the input unit takes data from us to the computer in an 

organized manner for processing. 

2. Storage: The process of saving data and instructions permanently is known as 

2) It stores data, 
 

3) It can process data as required by the user, 
 

4) It gives results in the form of output, and 

storage. Data has to be fed into the system before the actual processing starts. It is 

because the processing speed of Central Processing Unit (CPU) is so fast that the 

data has to be provided to CPU with the same speed. Therefore the data is first 



stored in the storage unit for faster access and processing. This storage unit or the 

primary storage of the computer system is designed to do the above functionality. 

It provides space for storing data and instructions. 

The storage unit performs the following major functions: 
 

• All data and instructions are stored here before and after processing. 
 

• Intermediate results of processing are also stored here. 
 

3. Processing: The task of performing operations like arithmetic and logical 

operations is called processing. The Central Processing Unit (CPU) takes data and 

instructions from the storage unit and makes all sorts of calculations based on the 

instructions given and the type of data provided. It is then sent back to the storage 

unit. 

4. Output: This is the process of producing results from the data for getting 

useful information. Similarly the output produced by the computer after 

processing must also be kept somewhere inside the computer before being given 

to       you in human readable form. Again the output is also stored inside the computer 

for further processing. 

5. Control: The manner how instructions are executed and the above operations 

are performed. Controlling of all operations like input, processing and output are 

performed by control unit. It takes care of step by step processing of all operations 

inside the computer. 

 
 

Q5. What do you know by Motherboard? Explain. 

Ans. The motherboard is the piece of computer hardware that can be thought of as the 

“backbone” of the PC. The motherboard connects all parts of a computer together. 

The CPU, memory hard drive, optical drives, video card, sound card and other 



ports and expansion cards connects to the motherboard directly via cables. 

Popular motherboard manufactures are Intel, ASUS, AOpen, ABIT, MSI, Biostar. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

It is a printed circuit board that is the foundation of a computer, located at the bottom of 

the computer case. It allocates power to the CPU, RAM, and all other 

computer hardware components. Most importantly, the motherboard allows hardware 

components to communicate with one another. 

Below is a listing of other motherboard components that are not shown in the picture 

above or were part of older computer motherboards. 

BIOS 

Bus 

Cache memory 

Chipset 

Diode 

Dip switches 

Electrolytic 

Fuse 

Game port and MIDI header 

Internal speaker 

Keyboard controller 

http://www.computerhope.com/jargon/p/pcb.htm
http://www.computerhope.com/jargon/c/cpu.htm
http://www.computerhope.com/jargon/r/ram.htm
http://www.computerhope.com/jargon/h/hardware.htm
http://www.computerhope.com/jargon/b/bios.htm
http://www.computerhope.com/jargon/b/bus.htm
http://www.computerhope.com/jargon/c/cache.htm
http://www.computerhope.com/jargon/c/chipset.htm
http://www.computerhope.com/jargon/d/diode.htm
http://www.computerhope.com/jargon/d/dipswitc.htm
http://www.computerhope.com/jargon/c/capacito.htm
http://www.computerhope.com/jargon/f/fuse.htm
http://www.computerhope.com/jargon/u/usbhead.htm
http://www.computerhope.com/jargon/i/intespea.htm
http://www.computerhope.com/jargon/k/keybcont.htm


LCC 

Network header 

Obsolete expansion slots (AMR, CNR, EISA, ISA, VESA) 

Obsolete memory slots (SIMM) 

Onboard LED 

Voltage regulator 

Voltage regulator module (VRM) ETC. 

 
 

Q.6. Explain about the System Bus. 

Ans.: Bus means the electronic path between various components Bus refers to 
particular types of a cable. Each cable of a bus carries information of one bit. Buses 
are of 3 types: 

(1) Address Bus 
(2) Data Bus 

(3) Control Bus 

(1) Address Bus : It carries the address of memory location of required 

instructions and data. The address Bus is unidirectional, i.e., data flows in 
one direction from CPU to memory. The address bus data determines the 
maximum number of memory addresses. This capacity is measured in 
binary form. E.g. A 2 –bit address bus will provide 22 addresses. 

(2) Data Bus : Data bus is an electronic path that connects CPU, memory & 
other h/w devices. Data bus carries the data from CPU to memory or I/P– 

O/P devices and vice versa. It’s a directional bus because it can transmit 
data in either direction. The processing speed of a computer increases if the 
data bus is large as it takes more data at one time. 

(3) Control Bus : Control Bus controls the memory and I/O devices. This bus 

is bidirectional. The CPU sends signals on the control bus to enable the 
O/P of the addressed memory devices. 

http://www.computerhope.com/jargon/l/lcc.htm
http://www.computerhope.com/jargon/u/usbhead.htm
http://www.computerhope.com/jargon/a/amr.htm
http://www.computerhope.com/jargon/c/cnr.htm
http://www.computerhope.com/jargon/e/eisa.htm
http://www.computerhope.com/jargon/i/isa.htm
http://www.computerhope.com/jargon/v/vesa.htm
http://www.computerhope.com/jargon/s/simm.htm
http://www.computerhope.com/jargon/l/led.htm
http://www.computerhope.com/jargon/v/voltregu.htm
http://www.computerhope.com/jargon/v/vrm.htm


Q.5. List out various Cards and elaborate about them? 

Ans.: (1) Sound Card: This card is used for I/P& O/P sound. Microphone is used  to 

I/P& speaker is used to O/P the sound. The sound card converts the sound 
into computer language & vice versa. All sound cards are based on MIDI 
(Musical Instrument Digital Interface) which represents the music in 

electronic form. The main part of sound card is DSP (Digital signal 
processor) which uses arithmetic logic to bring out sound effects. Sound 
card comes with 16-bit computers. DAC (Digital to Analog) and ADC 
(Analog to Digital) sound card uses DMA (Direct memory Access) channel 
is to read & write the digital audio data. 

(2) SCSI (Small Compute System Interface) : This technology is used in high 

speed hard disk. It’s often used in servers where high volume of data is 
used. At present different versions of SCSI are used.  The capacity of the 
SCSI is determined by the bus width and speed of the interface. Through 
SCSI the computers bus is extended by means of the cable. It’s an extension 
of the computer bus. 

 

(3) Network Cards : N/W card is a versatile device because it performs a 

number of tasks that contribute to the entire process of transmitting and 
receiving data between computers. It links a computer to another computer 
of the n/w through cable wires. A seven-layer model of OSI (Open System 
Interface) is used in the Internet for receiving and transmitting of data. The 
information passes through there seven layers. N/W card implements the 
physical layer and half of the data link layer. 

 

Q.6. Describe briefly about different types of Ports. 

Ans.: Computers have an interface called ports. Peripheral devices are interfaced to the 
computers through these ports. Data flows in & out through these ports. Ports are 
of 2 types, Parallel & Serial. 

A parallel port allows the transfer of all the bits of a word simultaneously. In 
parallel interface there are multiple lines to connect the peripherals to the port. A 
parallel interface is used to transfer data at a faster rate for higher speed 
peripherals such as disk and tapes. 

A Serial port allows serial data transfer. In serial data transfer, one bit of data is 
transmitted at a time. In serial interface, only one line or a pair of line is used to 
transmit data. It’s used for slow speed peripherals such as terminal. Printers 
employ either serial interface or parallel interface. The disadvantage of a serial/ 
parallel port is that only one device can be connected to a port. 

 
 
 
 

 



 
 

Chapter 2 

Storage Devices 

 
Q.1. How can you classify Storage Devices? What are its different types elaborate? 

Ans.: Storage devices or secondary storage devices are used to store data and 
instruction permanently. They are used in computers to supplement the limited 
storage capacity of RAM. 

Storage devices can be categorized in two parts : 

 

Storage Devices 

 
Magnetic Storage Optical Storage 

 
 
 

Floppy Disk Hard Disk       Magnetic Tape CD-Rom       DVD 

 

Floppy Disk : It’s a circular disk coated with magnetic oxide and enclosed within 

square plastic cover (Jacket). It’s available in different size, but the most 
commonly used floppy is 3½. Data up to 1.44 MB can be stored in it. Data is 
written as tiny magnetic spots on the dish surface creating new data or a disk 
surface eraser data previously stored at that location. Floppies are available in 2 
sizes, 3.5 inch & 5.25 inch. The 3.5 inch size floppy is mostly used. The 5.25 inch 
floppy is kept in a flexible cover & it’s not safe. It can store about 1.2 MB data. 

Hard Disk : Hard disks are made of aluminum or other metal alloys which are 
coated on both sides with magnetic material. Unlike floppy disks, hark disks are 
not removable from the computer. To remain the storing capacity several disks 



 

 

are packed together & mounted on a common drive to form a disk pack. A disk is 
also called a platter. 

Magnetic Tape : Magnetic tape is a mass storage device. It’s used as a back up 

storage. It’s a serial access type of storage device. Its main advantage is that it 
stores data sequentially. Standard sizes are ½ inch or ¼ inch or 8mm & 3mm wide. 
Some Head names of tapes are: DAT (Digital Audio tape) & DLT (Digital Liner 
Tape) etc. 

Optical Memory : Information is written to or read from an optical disk or tape 

using laser beam. Optical disks are not suitable memory storage units because 
their access time is more than that of hard disks. Their advantage is that they have 
very high storage capacity. Types of optical memory are: CD  –ROM, CD-R, CD- 
RW, DVD-ROM, DVD-R and DVD-RW. Information on  a  CD-ROM  is  written  at 
the time of manufacture. 

CD-R/W of 700 MB are available. 

A DVD-ROM is similar to CD-ROM. It uses shorter wave length of laser beam 
and hence, stores more data than CD-ROM. 

 

Q.2. Explain about Modem. 

Ans.: Modem is abbreviation for Modulator – Demodulator. Modems are used for data 

transfer from one computer to another through telephone lines. The computer 

works in digital mode, while analog technology is used for carrying massages 

across phone lines. Modem converts information from digital mode to analog 

mode at the transmitting end and converts the same from analog to digital at 

receiving end. Modems are two types : 

(i) Internal Modem 

(ii) External Modem 
 

 
Q.3. What is Formatting? 

Ans.: The process of magnetically mapping of a floppy is called formatting. Before 
 storing the data on a floppy, it needs to be magnetically mapped, so that data can 
 be stored in the right place. Every new floppy needs to be formatted before 

use. Formatting means, creating tracks & sectors on the floppy. Tracks are in the 



 

 

shape of circles on the floppy which divide it into various segments. The number 
of tracks depends upon the density of the floppy. In a high density floppy, up to 
80 tracks can be created. 

If a floppy has 80 tracks with each track having 20 sectors, then the number of 
sector would be 1600. 



Q4. Write the Difference between Random versus Sequential Access 

Ans. Sequential Access- A sequential access device is one in which the arrival at the 

location desired may be preceded by sequential through other locations , so that 
access time varies according to location. In other words, information on a serial 
sequence in which it is stored. It is suitable for such applications like preparation 
of monthly pay slips or monthly electricity bills etc. where each address needs to 
be accessed in turn. Magnetic tape and punched paper media are sequential 
storage device. 

 

Random Access- A random Access device is one in which any location in the 

device may be selected at random, access to the information stored is direct, 
and approximate equal access time is required for each location. Magnetic disk 
and magnetic drum are direct access storage devices. 

 

Q5. What is speed? 

Ans.  Speed refers to access information from a disk. The disk address of the desired 

data has to be specified. The disk address is specified in terms of the track 

number, the surface number, and the sector number. Information is always 

written from the beginning of a sector and can be read only from the track 

beginning. As soon as a read/write command is received by the disk unit, the 

read/write heads are first positioned on the specified track number by moving the 

arm assembly in the proper direction. This involves a mechanical motion of the 

arm and is slow. The time required to position the head over the proper track is 

called the seek time or speed. The speed or seek time varies depending on the 

position of the arm assembly when a read/write command is received. 

 

Q6. What do you understand by storage capacity? 

Ans. The storage capacity of disk system depends on the tracks per inch of surface and 

the bits per inch of track .Although the diameter of a standard size magnetic disk 

is 14 inches but some disks are quite large running upto 4 feet in diameter. Larger 

disks have more tracks and hence they have greater storage capacity. 



Q.1. Give short notes on various Input and Output Devices. 

Ans.: The devices which are used to input the data and the programs in the computer 

are known as “Input Devices. These devices convert what we input, into a form 
that is understandable by a computer. It provides man to machine 
communication. Some of the I/O devices are explained below: 

(1) Keyboard : The data and instructions are input by typing on the keyboard. 

The message typed on the keyboard reaches the memory unit of a 
computer. It’s connected to a computer via a cable. Apart from alphabet 
and numeral keys, it has other function keys for performing different 
functions. 

(2) Mouse : It’s a pointing device. The mouse is rolled over the mouse pad, 

which in turn controls the movement of the cursor in the screen. We can 
click, double click or drag the mouse. Most of the mouse’s have a ball 
beneath them, which rotates when the mouse in moved. The ball has 2 
wheels of the sides, which in turn mousse with the movement of the ball. 
The sensor notifies the speed of its movements to the computer, which in 
turn moves the cursor/pointer on the screen. 

(3) Scanner : Scanners are used to enter information directly in to the 

computers memory. This device works like a Xerox machine. The scanner 
converts any type of printed or written information including photographs 
into digital pulses, which can be manipulated by the computer. 

(4) Track Ball : Track ball is similar to the upside- down design of the mouse. 

The user moves the ball directly, while the device itself remains stationary. 

The user spins the ball in various directions to effect the screen movements. 
 

 

(5) Light Pen : This is an input device which is used to draw lines or figures on 

a computer screen. It;s touched to the CRT screen where it can detect raster 

on the screen as it passes. 

(6) Optical Character Reader: It’s a device which detects alpha numeric 

characters printed or written on a paper. The text which is to be scanned is 

illuminated by a low frequency light source. The light is absorbed by the 

dark areas but reflected from the bright areas. The reflected light is 

received by the photocells. 

(7) Bar Code Reader: This device reads bar codes and coverts them into 

electric pulses to be processed by a computer. A bar code is nothing but 

data coded in form of light and dark bars. 

(8) Voice Input Systems: This devices converts spoken words to M/C 

language form. A micro phone is used to convert human speech into 

electric signals. The signal pattern is then transmitted to a computer when 

it’s compared to a dictionary of patterns that have been previously placed 

in a storage unit of computer. When a close match is found, the word is 



recognized. 

(9) Plotter: Plotter is an O/P device that is used to produce graphical O/P on 

papers. It uses single color or multi-color pens to draw pictures as blue 

print etc. 

(10) Digital Camera: It converts graphics directly into digital form. It looks like 

an ordinary camera, but no film is used therein, instead a CCD (changed 

coupled Divide) Electronic chip in used. When light falls, on the chip 

though the lens, it converts light waves into electrical waves. 

 

Q.2. What is a Printer and what are the different types of Printers? 

Ans.: Printers are O/P devices used to prepare permanent O/P on paper. Printers can 
be divided into two main categories : 

Printer 

 
Impact 

 
Non-Impact 

  

 

Character Printer Lines Printer 
 

Character Printer 
 

Page Printer 

 
Dot Matrix 

 
Ink-Jet 

 
Laser 

 
 

(1) Impact Printers : In this hammers or pins strike against a ribbon and 

paper to print the text. This mechanism is known as electro-mechanical 
mechanism. They are of two types. 

(i) Character Printer 

(ii) Line Printer 

(i) Character Printer : It prints only one character at a time. It has relatively 
slower speed. Eg. Of them are Dot matrix printers. 

Dot Matrix Printer : It prints characters as combination of dots. Dot matrix 

printers are the most popular among serial printers. These have a matrix of 
pins on the print head of the printer which form the character. The 
computer memory sends one character at a time to be printed by the 
printer. There is a carbon between the pins & the paper. The words get 
printed on the paper when the pin strikes the carbon. There are generally 
24 pins. 



(ii) Line Printer : It prints one line of text at a time. They have higher speed 
compared to character printers. These printers have a poor quality of O/P. 
Chain printers and Drum printers are examples of line printers. 

(2) Non-Impact Printers : There printers use non-Impact technology such as ink-jet or 
laser technology. There printers provide better quality of O/P at higher speed. 
These printers are of two types : 

 
(i) Ink-Jet Printer : It prints characters by spraying patterns of ink on the paper from 

a nozzle or jet. It prints from nozzles having very fine holes, from which a 
specially made ink is pumped out to create various letters and shapes. The ink 
comes out of the nozzle in a form of vapors. After passing through a reflecting 
plate, it forms the desired letter/shape at the desired place. 

 
(ii) Laser Printer : It prints the entire page in one go. These printers have photo 

sensitive drum made of silicon. This drum is coated with recharge 
photoconductive, which is extremely sensitive to light. This drum is exposed to 
the laser rays reflected from the shapes to be printed. The area where there rays 
fall gets discharged. This drum while rotating comes in contact with toner and the 
toner gets attached to the discharged area on the drum. Then when the drum 
comes in contact with paper, the toner that has got attached to the drum in the 
original shape gets attached to the paper & hence printing takes place. The paper 
is slightly heated and the toner gets permanently attached to it. 

 

Q.3. What are the different types of Memory? 
Ans.: The memory in a computer is made up of semi-conductions. Semi-conduction 

memories are of two types : 

(1) RAM : Random Access Memory 

(2) ROM : Read Only Memory 

RAM : The Read and write (R/W) memory of a computer is called RAM. 

The User can write information to it and read information from it. In 
Random Access, any memory location can be accessed in a random 
memory without going through any other memory location. The RAM is a 
volatile memory, it means information written to it can be accessed as long 
as power is on. As soon as the power is off, it cannot be accessed. 

 

ROM : Read only memory: Its non volatile memory, ie, the information 

stored in it, is not lost even if the power supply goes off. It’s used for the 
permanent storage of information. It also posses random access property. 
Information cannot be written into a ROM by the users/programmers. In 
other words the contents of ROMs are decided by the manufactures 

 

Q4. Write ALU and its components? 
Ans.  It is a digital circuit that performs integer arithmetic and logical operations. 

The ALU is a fundamental building block of the central processing units of a 
computer, and even the simplest microprocessor contain one for purposes such as 



maintaining timers.it represents the fundamental building block of the central 
processing unit of a computer. 

 

 

Q6. Explain classification of computer in detail. 
Ans. Classification digital Computer based on size and Capability 

Based on size and capability, computers are broadly classified into 

        Microcomputers(Personal   Computer) 
A microcomputer is the smallest general purpose processing system. The older 
pc started 8 bit processor with speed of 3.7MB and current pc 64 bit processor 
with speed of 4.66GB Examples: -IBM 
PCs, APPLE computers 

 

Microcomputer can be classified into 2 types : 

1. Desktops 
2. Portables 

The difference is portables can be used while travelling whereas desktops 
computers cannot be carried around. 

The different portable computers are: - 
1) Laptop 

2) Notebooks 
3) Palmtop (hand held) 
4) Wearable computers 

Laptop: - this computer is similar to a desktop computers but the size is smaller. They 

are expensive than desktop. The weight of laptop is around 3 to 5 kg. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Notebook: - These computers are as powerful as desktop but size of these computers are 

comparatively smaller than laptop and desktop. They weigh 2 to 3 kg. They are more 
costly than laptop. 



 
 
 
 
 
 
 
 
 
 
 
 

 

Palmtop (Hand held): - They are also called as personal Digital Assistant (PDA). These 

computers are small in size. They can be held in hands. It is capable of doing word 
processing, spreadsheets and hand writing recognition, game playing,  faxing  and 
paging. These computers are not as powerful as desktop computers. Ex: - 3com palmV. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Wearable computer: - The size of this computer is very small so that it can be worn on 

the body. It has smaller processing power. It is used in the field of medicine. For example 
pace maker to correct the heart beats. Insulin meter to find the levels of insulin in the 
blood. 



Workstations:- It is used in large, high-resolution graphics screen built in network 

support, Engineering applications(CAD/CAM), software development desktop 
publishing 
Ex: Unix and windows NT. 

Minicomputer: -A minicomputer is a medium-sized computer. That is more powerful 

than a microcomputer. These computers are usually designed to serve multiple users 
simultaneously(Parallel Processing). They are more expensive than microcomputers. 

Examples: Digital Alpha, Sun Ultra. 
 
 
 
 
 
 
 
 
 
 

Mainframe computers: - Computers with large storage capacities and very high speed of 

processing (compared to mini- or microcomputers) are known as mainframe computers. 
They support a large number of terminals for simultaneous use by a number of users like 
ATM transactions. They are also used as central host computers in distributed data 
processing system. 
Examples: -     IBM 370, S/390. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Supercomputer: - Supercomputers have extremely large storage capacity and 

computing speeds which are many times faster than other computers. A supercomputer 
is measured in terms of tens of millions Instructions per second (mips), an operation is 
made up of numerous instructions. The supercomputer is mainly used for large scale 
numerical problems in scientific and engineering disciplines such as Weather analysis. 
Examples: -   IBM Deep Blue 



Q1. What is Operating System? 

Ans:  An operating system (OS) is a type of system software that manages computer’s 

hardware and software resources.. Application programs need a platform to run 
itself and operating system work as a platform to run application programs. 

Q2. Explain NTFS File System? 
 

Ans:  NTFS (New Technology File System) is the file system that the Windows NT 
operating system uses for storing and retrieving files on a hard disk.. NTFS has 
improvements and some advantages over FAT file system in performance, 
memory and security. 

 
There are following characteristics of NTFS : 

 

    NTFS support very large files (up to 2 to the 64th power or approximately 16 
billion bytes in size) 

    An access control list (ACL) that lets a server administrator control who can 
access specific files 
It provides compression of Files 
It does support for names based on Unicode 
NTFS gives Data security on Hard disks 

 
 
 

Q3. Explain FAT File System? 
Ans: The FAT(File Allocation Table) is a file system that provide a file allocation table 

situated at the beginning of a logical volume. FAT was earle designed for small 
disks and folders. There are two copies of the file allocation table are stored on 
disk. In any situation if one copy of the file allocation table is corrupted, the 
other file allocation table is used. 

 
Q4. Explain DOS with its Commands? 

 

Ans DOS stands for Disk Operating System is a operating system developed by 
Microsoft company for IBM, 

 
Following are the commands used in MS-DOS:-. 

http://searchwinit.techtarget.com/definition/Windows-NT
http://searchcio-midmarket.techtarget.com/definition/operating-system
http://searchexchange.techtarget.com/definition/file
http://searchstorage.techtarget.com/definition/hard-disk
http://searchstorage.techtarget.com/definition/byte
http://searchsoftwarequality.techtarget.com/definition/access-control-list
http://searchstorage.techtarget.com/definition/compression
http://searchcio-midmarket.techtarget.com/definition/Unicode


Append 
used by programs to open files in another directory as if they were located in the 
current directory. 

 

Attrib 
used to change the attributes of a single file or a directory. 

 

Break 
This command sets or clears extended CTRL+C checking. 

 

Call 
Itis used to run a script or batch program from within another script or batch 
program. 
The call command has no effect outside of a script or batch file. In other words, 
running the call command at the DOS prompt will do nothing. 

 

Chcp 
displays or configures the active code page number. 

 

Chdir 
The chdir command is used to display the drive letter and folder that you are 
currently in. Chdir can also be used to change the drive and/or directory that 
you want to work in. 

 

Cls 
This command clears the screen of all previously entered commands and other 
text. 

 

Command 
The command command starts a new instance of the command.com command 
interpreter. 

 

Copy 
This command does exactly that – it copies one or more files from one location to 
another. 

 

Date 
used to show or change the current date. 

 

Del 
The del command is used to delete one or more files. 

 

Dir 



used to display a list of files and folders contained inside the folder that you are 
currently working in. 

Diskcopy 
It is used to copy the entire contents of one floppy disk to another. 

 
 

Q6. What is operating System and its characteristics? 

Ans: An operating system (OS) is a type of system software that manages computer’s 

hardware and software resources.. Application programs need a platform to run 
itself and operating system work as a platform to run application programs. 

 

Examples of Operating System are-Microsoft Windows 7 ,Apple MacOS , 
Ubuntu Linux ,. 

Google Android iOS – 
 

There are some characteristics of Operating system as following- 
 

1. Job/Task management 
2. Resource management 
3. Input/output management 
4. Recovery of Error 
5. Memory management 



Unit 2 

MS-

WORD 

 
Q1. Give introduction of MS-WORD? 

Ans: 
 

There are following buttons which are shown in above image- 

Microsoft Office Button : This button provides access to menu commands in 

Word. This Button is replacement of File button in previous versions. This button 
have commands likeNew, Open, Save, Print and Recent Documents. 

 

Ribbon: This is in the area across the top of the screen that makes almost all the 

capabilities of Word available in a single area. It replaces the menus and toolbars 
in previous versions. 

 



Tab: This area on the Ribbon, contains buttons that are categorized in groups. 

The default tabs are Home, Insert, Page Layout, Reference, Mailings, Review 
and View. 



 

Quick Access Toolbar : It is a customizable toolbar at the top of a document. By 

default the Quick Access Toolbar provides the options as Save, Undo, and 
Repeat buttons and is used for easy access to frequently used commands. 

 

Title Bar : This is a horizontal bar at the top of an active document. This bar 

shows the name of the document and application. There are buttons such as 
Minimize, Restore and Close buttons are at the right end of the Title Bar.. 

 

Q2. Give shortcut keys of MS.WORD? 

Ans: There are following shortcut keys used in MS-WORD- 
 

To do this Press 

Switch to the next window. ALT+Tab 

Switch to the previous window. ALT+SHIFT+Tab 

Close the active window. CTRL+W or CTRL+F4 

Move to the next option or option group. Tab 

Move to the previous option or option group. SHIFT+Tab 

Switch to the next tab in a dialog box. CTRL+Tab 

Switch to the previous tab in a dialog box. CTRL+SHIFT+Tab 

Move between options in an open drop-down list, or 

between options in a group of options. 

 
Arrow keys 

Perform the action assigned to the selected button; 

select or clear the selected check box. 

 
SPACEBAR 

 
Select an option; select or clear a check box. 

ALT+the letter underlined in an 

option 

Open a selected drop-down list. ALT+DOWN ARROW 

Select an option from a drop-down list. 
First letter of an option in a drop- 



 down list. 

Close a selected drop-down list; cancel a command 

and close a dialog box. 

 
ESC 

Run a selected command. Enter 

Move to the beginning of the entry. HOME 

Move to the end of the entry. END 

 
Move one character to the left or right. 

LEFT ARROW or RIGHT 

ARROW 

Move one word to the left. CTRL+LEFT ARROW 

Move one word to the right. CTRL+RIGHT ARROW 

Select or cancel the selection of one character to the 

left. 

 
SHIFT+LEFT ARROW 

Select or cancel the selection of one character to the 

right. 

 
SHIFT+RIGHT ARROW 

Select or cancel the selection of one word to the left. CTRL+SHIFT+LEFT ARROW 

Select or cancel the selection of one word to the 

right. 

 
CTRL+SHIFT+RIGHT ARROW 

Select from the cursor to the beginning of the entry. SHIFT+HOME 

Select from the cursor to the end of the entry. SHIFT+END 

Display the Open dialog box. 
CTRL+F12 or CTRL+O 

Display the Save As dialog box. F12 

Open the selected folder or file. Enter 

Open the folder one level above the selected folder. BACKSPACE 
 



Delete the selected folder or file. DELETE 

Display a shortcut menu for a selected item such as a 

folder or file. 

 
SHIFT+F10 

Move forward through options. Tab 

Move back through options. SHIFT+Tab 

Open the look in list. F4 or ALT+I 

 
 
 
 

Cancel an action. ESC  

Undo an action. CT RL+Z  

Redo or repeat an action. CTRL+Y 
 

Move to a task pane from another pane in the program window. 

You may have to press F6 multiple times. 

 
F6 

When a menu is active, move to a task pane. You may have to 

press CTRL+Tab multiple times. 

 
CTRL+Tab 

When a task pane is active, select the next or previous option in the 

task pane. 

 
Tab or SHIFT+Tab 

Display the full set of commands on the task pane menu. CTRL+SPACE BAR 

Perform the action assigned to the selected button. SPACE BAR or Enter 

Open a drop-down menu for the selected gallery item. SHIFT+F10 

Select the first or last item in a gallery.  HOME or END 

 
Scroll up or down in the selected gallery list. 

PAGE UP or PAGE 

DOWN 



UNIT -3 

MS- POWERPOINT 

 
Q1 Give introduction of MS Powerpoints- 

Ans 

 

 
When you open PowerPoint from the Start menu or from an icon on your 
desktop, a new presentation with one slide appears by default. You can also 
create a new presentation while PowerPoint is already open. 

 

    Click the Microsoft Office button, and choose New from the menu. 



 
 

    The New Presentation dialog box will appear. Blank presentation is selected by 
default. 



 
 

    Click Create, and a new presentation will open in the PowerPoint window. 
 

The default slide that appears when you create a new presentation is a Title 
Slide layout. 

 

Q2. How to change theme of a slide? 
 

Ans 
 

For customizing a theme, you start by changing the colors, the fonts, or the line 
and fill effects that are used. 

 
Customize theme colors 

 
Theme colors contain four text and background colors, six accent colors, and two 

hyperlink colors. The colors in the Theme Colors button represent the current 
text and background colors, and the set of colors next to the Theme Colors name 
after you click the Theme Colors button represent the accent and hyperlink 
colors for that theme. When you change any of these colors to create your own 
set of theme colors, the colors in the Theme Colors button and next to the Theme 
Colors name change accordingly. 



1. On the Design tab, in the Themes group, click Colors. 
 

 

2. Click Create New Theme Colors. 
3. Under Theme colors, click the button next to the name of the theme color element 

that you want to change. 
4. Under Theme Colors, click the color that you want to use. Repeat steps 3 and 4 

for all of the theme color elements that you want to change. 
 

Tip Under Sample, you can see the effect of the changes that you make. 
 

5. In the Name box, type an appropriate name for the new theme colors, and then 
click Save. 

 
Tip If you want to return all theme color elements to their original theme colors, 
click Reset before you click Save. 

 
Customize theme fonts 

 
Theme fonts contain a heading font and a body text font. When you click the Theme 

Fonts button , you see the name of the heading and body text fonts used for each 
theme font below the Theme Fonts name. You can change both of these fonts to create 
your own set of theme fonts. 

 
1. On the Design tab, in the Themes group, click Theme Fonts. 

 

 

2. Click Create New Theme Fonts. 
3. In the Heading font and Body font boxes, select the fonts that you want to use. 

 
Tip Under Sample, you can see sample text in the font style that you select. 

 
4. In the Name box, type an appropriate name for the new theme fonts, and then 

click Save. 



Select a set of theme effects 
 

Theme effects are sets of lines and fill effects. When you click the Theme Effects button , 
you see the lines and fill effects used for each set of theme effects in the graphic 
displayed with the Theme Effects name. Although you cannot create your own set of 
theme effects, you can choose the one that you want to use in your own document 
theme. 

 
1. On the Design tab, in the Themes group, click Theme Effects. 

 

 

2. Click the effect that you want to use. 
 

Q3 How we can apply animation and transition In a slide? 

Ans: 

Add Animations 
 

PowerPoint provides four types of animations: Entrance, Emphasis, Exit, and 
Motion Paths. After you add an animation, you can use the Custom Animation 
pane to modify it by choosing an effect. Choosing an effect enables you to define 
what starts the animation, its properties (such the direction from which an object 
moves onto the slide), and control the speed of the animation. In addition, you 
can have an animation start when you click the mouse, start along with the 
previous animation, or start at a specified time after the previous animation. 

 

You may also use the Play button  on the Custom Animation pane to 
preview an animation. 

 
To choose an effect: 

 
1. Select the object you want to animate. 
2. Choose the Animations tab. 

3. Click the Custom Animation button . The Custom 
Animation pane appears. 

4. Click the Add Effect button . A menu appears. 
5. Choose the type of effect you want. A submenu appears. 
6. Click the effect you want. PowerPoint applies the effect. 



To modify an effect: 
 

1. Click the down arrow next to the Start field on the Custom Animations pane and 
then select the start method you want. 

2. Click the down arrow next to the Property field on the Custom Animations pane 
and the select the property you want. The Property field might be labeled 
Direction, Size, or some other property. 

3. Click the down arrow next to the Speed field on the Custom Animations pane 
and then select the speed you want to apply to your animation. 

 

To preview the animation, click the Play button on the Custom Animations 
pane. 

 

 

1. Click Slide 2 on the Slides tab. 
2. Select "Start saving early." 
3. Choose the Animations tab. 

4. Click the Custom Animation button . The Custom Animation 
pane appears. 

5. Click the Add Effect button . A menu appears. 
6. Choose Entrance. A submenu appears. 
7. Click Fly In. PowerPoint applies the effect. If the Auto preview box is checked, 

PowerPoint automatically provides you with a preview of the animation. 



 

Add Transitions 
 

Transitions determine how your presentations move from one slide to the next. For 
example, a slide can move up onto the screen and replace the previous slide. 
PowerPoint provides several transition methods. You can add sound to a transition and 
you can control its speed. You can apply a transition to selected slides or to all of the 
slides in your presentation. 

 
A transition can occur when the presenter clicks the mouse or after the amount of time 

you specify. 
 

To apply a transition to selected slides: 
 

1. On the Slides tab, hold down the Ctrl key and then click the slides to which you 
want to apply the transition. 

2. Choose the Animations tab. 

3. Click the More button in the Transition to this Slide group. A menu of 
transitions appears. 

4. Click the transition you want to apply. PowerPoint applies the transition. As you 

roll your pointer over each transition, PowerPoint provides you with a live 
preview of the transition. 

 
To apply a transition to all slides: 

 
1. Choose the Animations tab. 

2. Click the More button in the Transition to this Slide group. A menu of 
transitions appears. 

3. Click the transition you want to apply. As you roll your pointer over each 
transition, PowerPoint provides you with a live preview of the transition. 

4. Click the Apply to All button in the Transition to This Slide group. 

To add a sound to a transition: 
 

1. Choose the Animations tab. 
2. Click the down arrow next to the Transition Sound field and then click the sound 

you want. As you roll your pointer over each sound, PowerPoint plays the 
sound. 

 
To set the speed of a transition: 

 
1. Choose the Animations tab. 



2. Click the down arrow next to the Transition Speed field and then click the speed 
you want. 



UNIT – 

4 MS-

EXCEL 

 
Q1 Give introduction of MS-EXCEL? 

 

Microsoft Excel is a spreadsheet application program offered in the Microsoft 

office software package. This program allows you to perform calculations and 
use graphic tools, pivot tables, and a macro programming language called VBA. 
In addition, Excel can also be used to create charts and graphs 

 
After finishing this course you should be able to do the following: 
• Start Excel 

• Identify the items on the Excel program screen 
• Know how to use Toolbars 

• Customize Toolbars 

• Work with Sheets 
• Create a New spreadsheet 

• Open an existing saved excel sheet 

• Save a sheet 



• Convert Excel to PDF 

• Rename a sheet 

• Work on multiple sheet 



• Enter the data 
• Insert and Delete rows/columns 

• Create Tables 

• Draw charts 

• Inserting Picture/Hyperlinks/Symbols 

• Enter a formula 

• Import, Filter and Sort the data 

• Freeze/Unfreeze Worksheets 

• Use Pivot tables 
 

Starting Excel: 
1. Go to the Start Button on the Desktop and press it. Click on All Programs. 

2. Then click on Microsoft Office, then Microsoft Office Excel 2007 
.3. This opens the Excel 2007 program 

 
Creating a New 
Sheet 
Click on the New button after clicking office button. 

 

Q2 Explain functions used in MS-EXCEL? 
 

Ans A function is a predefined formula in MS-ACCESS that performs calculations 
using specific values in a particular order. 

The benefit of functions is that they can save you time because you do not have 
to write the formula yourself as there are prebuilt formulas. For example, you 

could use an Excel function called Average to quickly find the average of a range 

of numbers or the Sum function to find the sum of a cell range. 

 

Basic function’s Features 
 

1. All functions begin with the = sign. 

2. After the = sign, define the function name (e.g., Sum). 

3. Then there will be an argument. An argument is the cell range or cell 

references that are enclosed by parentheses. If there is more than one 
argument, separate each by a comma. 

 
An example of a function with one argument that adds a range of cells, A3 
through A9: 

 



An example of a function with more than one argument that calculates the sum 
of two cell ranges: 

 

Excel literally has hundreds of different functions to assist with your 

calculations. Building formulas can be difficult and time consuming. Excel's 
functions can save you a lot of time and headaches. 

 

Excel's different functions 
 

There are many different functions in Excel 2007. 
 

Statistical functions: 
 

SUM: Adds a range of cells together 
AVERAGE: Calculates the average of a range of cells 
COUNT: Counts the number of chosen data in a range of cells 
MAX: Identifies the largest number in a range of cells 

MIN: Identifies the smallest number in a range of cells 

Financial functions: 
 

Interest rates 
Loan payments 
Depreciation amounts 

Date and time functions: 
 

DATE: Converts a serial number to a day of the month 
Day of Week 

DAYS360: Calculates the number of days between two dates based on a 360-day 
year 
TIME: Returns the serial number of a particular time 
HOUR: Converts a serial number to an hour 
MINUTE: Converts a serial number to a minute 
TODAY: Returns the serial number of today's date 
MONTH: Converts a serial number to a month 
YEAR: Converts a serial number to a year 



 

UNIT - 

5 MS- 

ACCESS 

 
Q1. Give introduction of MS-ACCESS? 

Ans 

 
 

Microsoft Access 2007 is a Database Management System that 
creates a relational database to perform variousdata-tracking needs of an 
organization. Access 2007 provides the user with different kind of features for 
creating and editing data organized into tables, forms, and reports. 



Q2 How can you create Database and Table in MS-ACCESS? 
 

Ans  First of all, open Access by clicking on the desktop icon, or choose Access from 
the start menu. This brings up the getting started with microsoft office access 
screen. 

 

To Select Blank Database Template following are steps 

 

 
Towards the top left of the screen you will see a "Blank Database" icon. Click this 
icon to bring up the Blank Database side bar on the right hand side of the screen. 
This is where you will enter details about the database file that you are about to 
create. 



Now Enter filename for your Access 2007 database 

 
Begin by entering the name that you want to call the database in the filename 
textbox. Now. Click on Create 

 
MS Access 2007 Table creating steps are- 

 
start by opening your existing database file if it is not already open. Your blank 
database file should now be fully open. 

 

 
Select the CREATE tab on the Access ribbon. Next select the TABLE DESIGN 
icon from the TABLES group. This creates a new table. 

 



This opens the TABLE DESIGN GRID where you enter each field name and its 
data type. The first field we are going to create is the ID field which is going to 
contain a unique reference number for each record. On the next row the field is 
going to be called FIRSTNAME and the data type is going to be TEXT. On the 
third row the field name is SURNAME with the data type again being TEXT. 
And finally, the last field name is AGE and the data type here is going to be 
NUMBER. 

 
Before you save the table you will need to choose the Primary Key, which in this 
case is ID. To do this, select the ID row by clicking on it, and then simply click 
the primary key symbol on the Ribbon. 

 

 
The table design grid should now look like this: 

 

 
You can now save the table by clicking the save icon on the top left of the screen 
above the Access Ribbon. To view your table select DATASHEET VIEW from the 
VIEWS group under the DESIGN TAB. This brings up the datasheet view of the 
table that you have just created. You should see your field headings running 
across the top of the table. 

 



Q3 How can you create Forms in MS-ACCESS? 
Ans Access can automatically create different types of forms. As, when you click the 

Form button on the Create tab, Access places all fields in the selected table on a 
form.. 

Following are the steps to create Form:- 

 

 
1. Open the Navigation pane. 
2. Click the table or query on which you want to base your form. 
3. Activate the Create tab. 
4. Click Form in the Forms group. Access creates a form. 

 
 

You can use the Navigation bars to move through the records on a form. 
 

 

1 Go to First Record 

2 Go to Previous Record 

3 The Current Record 

4 Go to Next Record 

5 Go to Last Record 

6 Create a New (Blank) Record 

 
You can save your form with following steps:- 

 
1. Click the Save button on the Quick Access toolbar. Access saves the form unless 

you are saving for the first time. If you are saving for the first time, the Save As 
dialog box appears. 

2. Type the name you want to give the form. 
3. Click OK. Access saves the form. 



Q4 How can you create Reports in MS ACCESS? 

Ans Report Wizard is used to select what fields appear on your report. You can also 
define how the data is grouped and sorted. 

 

1. On the Create tab, in the Reports group, click Report Wizard. 
2. Follow the directions on the Report Wizard pages. On the last page, click 

Finish. 
 

. 
 

Q5 How can you create Query in MS ACCESS? 

Ans Following are the steps to create query of a Table- 
 

1. Click the Create tab, and then the Query Design button at the right hand end. 
 

2.  You can also use the Query Wizard. To create a Query but here we are doing 
it by Query Button. 

3. Access asks you which tables you want to ask questions about. 

 
 

Click on table on which you want your query, and click the Add button. The window 
stays open, so click the Close button. 

 
Access presents you with the query design page. 



 
 

The upper portion of the screen contains all of the included tables, with a list of 
the fields. The lower portion is where the questions are asked. 

 
First, you need to choose which of the fields in the table you want to either ask 
questions about, or wish to include in the answer. To choose, double-click the 
field, or drag it to the grid below. 

 
We have already chosen the fields, and the tables are added automatically. The 
next thing is the sort. To sort the books by rating for instance, click in the sort box 
for that column, and change the setting to Ascending or Descending. 

 
 

In our case, we want to only see books where the Title starts with “˜S’, and the 

rating is better than 2. The “˜S’ criteria also includes what is known as a wild 

card. That is, the title needs to start the letter S, but anything at all is permitted 
after that. 

 
Numeric criteria are allowed to be defined as limits, rather than specific values, 
so in the case we can use the “˜>’ operator. 
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Finally, you can save the query for later.. 
 

. 
 


























